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Warning
Permanent damage may be done to the thermometer if the power supply connections are not done correctly.
In particular, do not connect the power input (18-24VDC) to any of the analog output connectors. Note that
the 20 mA analog output options are self-powered interfaces (by opposition to loop-powered interfaces), and
thus do not require any external supply.
Fiber optic probes are fragile, and will break if the bending radius becomes less than ~1cm, even temporarily.
Probe breakages are not covered under the standard Omega warranty.
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1 INTRODUCTION
Congratulations on the purchase of your FOB100 Series thermometer product! Your new temperature
sensing system will soon allow you to take full advantage of the benefits inherent to fiber optic sensing
technology. It offers accurate and reliable temperature measurements, combined with extraordinary
insensitivity to EMI/RFI, high voltage insulation and disturbance free sensing due to the non-electrical nature
of the sensor element used.
Not only does the FOB100 Series of products gives users’ access to reliable measurements, but it also offers
a simple user interface that makes the technology easy to use. Moreover, no special calibration is required
when changing the fiber optic sensor elements.
The thermometer is packaged in a small splash proof package, which is ideally suited for industrial and
laboratory applications.
The standard configuration is offered with an RS-232 interface as well as an analog output feature (1, 2 or 4
channels) that can be used for remote interfacing purposes. In addition, a green fluorescent display makes it
o
o
easy to see the temperature for up to 4 channels, either in Celsius ( C) or in Fahrenheit ( F), even in dark
areas; it also includes a simple 3-key keypad that gives the user access to all built-in features; these standard
features are great for laboratory applications.
An optional software package, FOB100-SOFT, makes your thermometer even more useful. It is easy to use,
and allows the user to easily monitor even multiple thermometers at the same time, and to perform easy data
logging. PC compatible.

1.1 FOB100 product specifications
Resolution
Accuracy
Calibrated Temperature
Range
Usable Temperature
Range
Number of channels*
Probe length
Response time
Unit
Operating temperature
Storage temperature
Local display
Power
Size
Weight
Standard interface
Sensor (FOBS-XX)

0.1°C
The greater of 1°C or 1% of reading
-40° to 200°C
-80° to 250°C
1, 2 or 4
1 to 300 meters
Typically 0.4 to 1 second per channel
(probe configuration dependent)
User selection of °C or °F
0° to 45°C, non-condensing
-30° to 60°C
Display of channel number and temperature readings as well as other
user information.
14 to 28 VDC
(see note below, front panel item #10)
228L x 140W x 65D mm
1.0 kg
RS-232C
Analog output* (0-10V standard or 4-20mA option)
Dielectric silicone tipped optical fiber

*: Selection must be specified at time of order.
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The following figure gives a description of the various probe configurations that are o
optionally
ptionally available from
Omega.
General Purpose Probe FOBS
FOBS-2:

Coupling,, included with extension cable:

FOBS-CAB-(*) Extension Cable
Cable:

Other options and configurations are
e also possible; contact Omega for more information.

1.2 Calibration
Your FOB thermometer comes factory
factory-calibrated. An annual re-calibration
calibration is recommended every 12 months
or whenever performance
nce verification indicates that calibration is necessary; NIST traceable calibration
certificates are available. All calibrations are performed at the factory. Con
Contact
tact your Omega representative for
further information.
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2 UNPACKING
Before using your FOB100 thermometer, check the box content to be sure all items have been included. Your
package should normally contain:
•
•
•
•
•

FOB100 series signal conditioner unit
Power supply module (universal input: 100-240VAC, 50/60Hz)
RS-232C interface cable
User manual (this manual)
Calibration Certificate.

Options:
• Fiber optic temperature sensor probes
• Fiber optic extension cables
• Fiber optic coupling
• FOB100-SOFT software (CD).
Make sure all listed items have been received and are in good condition. Note any evidence of rough
handling in transit; immediately report any damage to the shipping agent. Should a part be missing or
damaged, please contact your distributor immediately. Returns must be made with the original packaging,
accompanied by an authorization number (RMA). Omega Customer Service Department will provide you with
information concerning the return of merchandise; you can contact Omega at (800) 622-2378 or (203) 3591660.
The carrier will not honor damage claims unless all shipping material is saved for inspection. After examining
and removing contents, save packing material and carton in the event reshipment becomes necessary.
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3 FOB100 SERIES THERMOMETER HARDWARE REFERENCE
The following figure shows the thermometer front panel:

4
5

3
2

6
7

1

The FOB100 back panel is as follows:
8

9
10

The following presents a full description of the user interface as well as detailed instructions on how to use
the thermometer.
1) Sensor status light(s): There is a total of up to 4 lights for this, one for each channel. These indicators
inform you about the system status, as applicable to each channel. If any remains off, this indicates that
either that channel is disabled or there is a problem with that sensor (or with the optional patch cord
connected to it). Check if all optical connectors are correctly mated or if the sensor fiber (or patch cord) is not
broken.
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2) Serial communication status light: These indicators are directly connected to the Tx and Rx lines of the
RS-232 interface. This is useful to confirm a good communication link with your PC when the FOB100-SOFT
FOB100
software package is used.
3) RS-232
232 communication interface: This port is used to configure and extract information for the
instrument. This DB-9
9 connector uses the same pin
pin-out
out as a COM port on a PC computer. Use a simple pinpin
to-pin wired cable (not
not a null modem cable
cable)) to connect to a computer. See below for a complete description
of the serial commands that are available.
4) 2 x 16 Display: Under normal use, the display will show the temperature readings for the user selected
o
o
channels; the temperatures are displayed in either C or F. However, when the FNCT key is used,
information is displayed to guide the user in making the selections (see item 5 below).
5) FNCT and SET keys: When the FNCT key is not activated; the display will show the temperatures for the
requested channels. The FNCT key allows the user to scroll through the menu items. All settings are kept in
permanent memory, until changed again by the user, using either the keypad or a RS232 command.
This key allows users to scroll through the different options.
This key allows users to browse from field to another, for options that have many fields.
This key allows users to set a value to the selected field.
The description of each of the menu items is:
1- Sampling rate: Adjust the resolution of the display. In Fast mode, the instrument focuses on faster
response time. In Slow mode, the focus is on higher resolution; this is ach
achieved
ieved by averaging the last
4 temperature measurements, which tends to reduce the noise, but to increase the effective
response time. In Slow mode, the display shows gives temperatures in hundredths of degrees, while
in Fast mode the display is in tenths o
of degrees.
2- Ch Enable Scan: Enable or disable the reading of a channel. Channels that are turned off are not
read, thus allowing the “on” channels to be read faster.
3- Temp. Unit: Enable users to change the temperature unit of the instrument. The thermometer will
continue to display temperatures using the newly selected unit.
6) Power switch. Make sure the FOB100 power supply module is connected and powered. At power on, a
series of messages are displayed (actual information may differ
differ):

FOB100
Single Channel
www.omega.com
www.omega.com
Ver: 0.2.25
cal: 06/11/141
Then temperatures should then be displayed, assuming they are correctly connected, and so forth. If
temperatures are unreadable, ----- will be displayed.
7) Power status light.
8) Sensor connector(s): These are ST type connectors, mating to each of the 4 optical temperature
sensors. If you need to extend a sensor fiber, you should use optional patch cor
cords
ds that are available from
Omega.. For thermometers that have 1 or 2 channel(s), only 1 or 2 sensor cconnectors
onnectors are used.

1

This is the calibration date (format YY/MM/DD
YY/MM/DD).

8

Warning: The fiber type that is used with your thermometer is of a special type, and it is
recommended that you get ALL of your patch cords (also called extension cables) from Omega.
9) Analog output connector(s): There are a total of 1, 2 or 4 such connectors, one for each channel. Prior
to shipment, your FOB100 thermometer was factory set to one of the following configurations: 4-20mA or
0-10V output. The minimum analog output value corresponds to minus 100°C and the maximum analog
output value corresponds to 300°C. The thermometer normal range is from minus 80°C to 250°C, so a
minimum value indicates an under-range error; likewise, a maximum value indicates an over-range error
condition. If there is a sensor problem for a given channel, the analog output may take one of the following 3
states (refer to the RS-232 “o” command, Section 5.3):
a) It will toggle between the minimum and maximum values, at approximately 0.5 Hz, this indicates a
sensor problem for that channel (o0). This is the default setting; to change it, you will need to use the
RS-232 “o1” or “o2” command.
b) The analog output is forced to its maximum value (o1); this would indicate a “too-hot” situation.
c) The analog output is forced to its minimum value (o2); this would indicate a “too-cold” situation.
Warning: Do not connect any external voltages to these outputs; this may cause permanent
damage to the thermometer unit.
Note: If the unit is in “sleep” mode, the analog outputs will keep their values until the FOB100 acquires new
temperature values.
10) 18 Volts DC power connector: You can use a DC power supply from 14V to 28V; note that at 15V or
less, you will be unable to use more than one (1) 500Ω load at the analog output, for all current output
configurations. There is an internal fuse, to protect the system in case of electrical problems; this fuse is not
user changeable.
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4 USING THE TEMPERATURE PROBES
4.1 Caution
Each time you connect a temperature probe to the unit, the probe optical connector should be cleaned
beforehand. Otherwise, particles of grease or dirt may obstruct the device internal connector and affect the
measurements by completely blocking the signal or by generating too much attenuation when using a long
fiber length.
Never use a cloth other than the type recommended for fiber optic cleaning. Dampening the cloth with pure
isopropyl alcohol ensures good cleaning.
Occasionally, clean the inside of the bulkhead connector (attached to the thermometer) with a wipe or cotton
swab dipped in alcohol (2.5 mm mini foam swabs work best).

Locking nut

Ferrule key
Ferrule

0

For very dirty connectors, acetone can also be used, but should be used very carefully, as it is a very strong
solvent. Care should be exercised so you do not apply any on plastic materials, etc.

4.2 Description
The optical connector used is a standard ST type connector.

Device connector
Insert the Ferrule key here

Pins BNC type
To install the connector,
Slide the ferrule key gently into the above key.
Then, turning, insert the two BNC pins into
The appropriate slots on the ST connector.
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4.3 Warning
The FOBS-XX probe is quite fragile and it must be handled carefully. Please note that any probe damages
are not covered by the standard warranty.
The probe tip is made of silicone rubber. Although silicone is resistant to a large number of chemical
aggressors, strong acids or alkali may damage it, especially at high temperature and/or if used for extended
periods of time. Warning: Solvents and fuel oils can cause problems for silicone rubber.
Omega also manufactures probes that have their tips made of epoxy. Just like silicone, epoxy resin is
resistant to a large number of chemical aggressors, strong acids or alkali may damage it, especially at high
temperature and/or if used for extended periods of time.
Contact your distributor for additional chemical compatibility information.
Do not expose your probes to temperatures that are higher than specified. Permanent damage can be
caused to probes that have been exposed to temperatures that are higher than their limits.
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5 SERIAL COMMUNICATION DESCRIPTION
You can communicate with your thermometer via the standard RS-232 link. A description of the cable
requirements is given above, under front panel item # 3.
RS-232 functions (or commands) can be accessed with a simple terminal, with the FOB100-SOFT software
package or simply with a computer and communication software (such as Windows Hyper Terminal). Your
software should be set at 9600 Baud, 1 Stop-Bit and No-Parity.

5.1 Using Hyper Terminal in Windows
2

Hyper Terminal is a standard Windows program that can be easily used to exercise your FOB100
thermometer. To use Hyper Terminal you first set its properties as follows:
1- In the “Connection Description” window, enter a name that suits you, such as “Omega-FOB100”.
Click OK.
2- In the next window, “Connect To”, select COM1 (or another COM port, if you are planning to use
another port than COM1) in the box called “Connect using”. Click OK.
3- Then the COM1 Properties window will come up. As indicated above and as shown in the figure at
right, set the port parameters to 9600 Baud, 1 Stop-Bit and No-Parity. Click OK.
4- You are ready to go. Type “h E” to test your setup (see below). Warning: the characters that you
enter are not echoed to you!

5.2 RS-232 help menu
The following is the menu as displayed by the instrument when sending the “h” command. Note that the
RS232 interface can also be used to upgrade the thermometer controlling firmware, without opening the
thermometer case or changing any memory IC’s. Instructions to perform an upgrade are normally sent with
the upgrade program; a PC compatible computer will be required to perform such firmware upgrade.

2

Vista users: HyperTerminal is not included with Vista. However, an equivalent program (HTPE) can be
downloaded (free for personal use) at the following website: http://www.hilgraeve.com/htpe/download.html.
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FOB101

FOB102 or 104

Description

b

b

Return enclosure temperature

N/A

e[1;2; ... ;n]

Enable channels to scan (if no argument, scan all)

f[j]

f[i;j]

Set point adjustment on channel [i] to [j]

h

h

Help menu (this screen)

i

i

Get factory and status information

l[i]

l[i]

Lock the keypad (l+ to lock, l- to unlock)

o[i]

o[i]

Analog out, if error (0:Max-Min 1Hz, 1:Max level, 2: Min level)

p[i]

p[i]

Sleep mode (p+ to sleep, p- for continuous scanning)

q

q

Scanning rate (q+ for fast/quick, q- for slow)

s[j]

s[i;j]

Specify analog output Span [j] for channel [i]

t

t[i]

Get Temperature reading channel [i]

ta[i]

ta[i]

Auto temperature output to serial port (+ to enable, - to disable)

u[i]

u[i]

Unit (c = Celcius, f = Fahrenheit)

y

y

Quality index

z[j]

z[i;j]

Temperature [j] for analog output Zero on channel [i].

o

o

5.3 Detailed description of RS-232 commands
All commands must be terminated by a carriage return character ( E ). When more than one argument
are required, each argument must be separated from the next one by a blank or space character. Characters
are not echoed back to your controlling device.
Every time a command is executed successfully by the thermometer, the “*” prompt character is
automatically sent, except in case of failures when the “Errx” error code is sent instead. Do not send your
next command before receiving either the “*” or the “Errx” prompt. The “[“ and “]” characters must not be
typed in; they are used here for ease of reading only.
Most commands are applicable to all FOB100 models (different number of channels). When using onechannel model, the channel number [i] must not be typed in.
o

o

“b” This command returns the internal temperature of the enclosure. The temperature is returned in C or F
unit, as specified by the “u” command.
ex:
“b:32.2 E“
“e[[-]1 [-]2 ... [-]n]” This command is not recognized by the one-channel model. Specify which channels
are enabled and read by your thermometer. Preceding a channel number with the minus sign “-” will disable
that particular channel. This command is useful to ignore channels that are not currently used. Enter the
channel numbers that you would like to use, each one separated by a blank character.
ex:
“e-1 2 3 E“, to enable only channels 2 and 3 and at the same time to deactivate channel 1.
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“f[j]” or “f[i j]” This command forces an actual temperature reading (j) for channel # i; any resulting offset
will be applied to all future measurements for that channel. This is useful to compensate for small
o
temperature deviations that may occur between sensors. A maximum offset of +/-5 C is recommended; if it is
required for you to force a larger offset, your thermometer probably requires a new factory calibration; consult
your distributor or factory for more information. This command alters the internal calibration of the instrument.
Always follow the recommended procedure, as given below.
Force temperature procedure:
I.
II.
III.

IV.
V.

Apply a stable and known temperature to the sensor tip
Check the display reading for abnormal deviation from the known temperature
Send the “f” command followed by channel number, a blank character and the reference
temperature value (example “f2 27.0 E“). Temperatures must be entered in units as
specified by the “u” command
Wait a few seconds
Confirm that the readings correspond to the known temperature.

Note: You can revert at any time to the factory calibration using the “f” (or “f[i]”) command (ex: “f2 E”).
Note: Always make sure you are reading a valid temperature value before using the “f “ command; otherwise,
your thermometer may display a random value for a channel where the “f” command has been used.
“h” Displays a help menu screen (see above).
“i” Returns general information regarding the instrument, as well as some parameters that have been
programmed previously in the thermometer (either by RS-232 commands or via the keypad):
Ex: Model:
FOB100
Option:
NB Channel: 4
Mode:
Continuous Scanning Mode
Scanning rate:
Fast
Serial:
FOB111A
Internal Software:
V1.21
Last Factory Calibration*:
05/02/04 (YY/MM/DD)
o
C
Unit
Analog out, if error
Toggle Max-Min 1Hz
Keyboard Status:
Unlock
Channel
Zero
Span
Enabled
Temperature offset*
1
xxx.x
xxx.x
Yes/No
±xxxx.x
2**
xxx.x
xxx.x
Yes/No
±xxxx.x
3**
xxx.x
xxx.x
Yes/No
±xxxx.x
4**
xxx.x
xxx.x
Yes/No
±xxxx.x
*: Temperature differential that is a consequence of the “f” command.
**: Only for multi-channel models.
“l[i]” This command is useful to prevent a local user from configuring the thermometer using the keypad. “i”
can take two values: “+” or “-“; entering “l+” will lock the keypad, while “l-“ will unlock it, thus enabling a user to
make local changes. If a user attempts to use a locked keypad, the message “LOC” is briefly displayed and
the command is rejected. A locked keypad can only be unlocked using the “l-“ RS-232 command.
“o[i]” This command can be used to change the behavior of the analog output(s) when the FOB100
thermometer cannot read a temperature for this channel. “i” can take one of three values:
a)
i=0. With this setting, the analog output will oscillate between its maximum and its minimum value at
a rate of approximately 1Hz.
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b)
c)

i=1. In case of a probe problem, the analog output for this channel will be forced to its maximum
possible value (e.g., 10V or 20mA).
i=2. In case of a probe problem, the analog output will be forced to its minimum possible value (e.g.,
0V or 4mA).

“p[i]” This command allows the user to force the thermometer to enter in sleep mode (p+) or to exit it (p-).
Once in sleep mode, the thermometer will acquire new temperature values ONLY when the “t” or “t[i]”
command is received; when the t command is received, the thermometer will immediately scan all enabled
channels, and the new temperature values will be displayed and sent through the RS-232 link, after which it
will return again in sleep mode (there is no need to resend the p+ command again).
a)
When the thermometer is powered on, the sleep mode is always disabled.
b)
When new temperature values are acquired, these new values will be shown on the display (if
present) for about 40 seconds, after which “Sleep mode” will be displayed.
c)
The analog outputs will keep the last temperature readings, until new ones become available.
d)
The front panel led status lights will keep their values until new readings are acquired.
“q” “q” allows for selecting the fast (q+) or the slow (q-) acquisition mode. This is equivalent to the Sampling
Rate selection that is available on the FOB100 keypad. In slow mode, the last 4 temperatures are averaged
before being displayed or sent to the RS-232 port; this provides a better reading at the expense of being
slower.
“s[j]” or “s[i j]” This command will set the analog output span for the analog channel # i (if using a multichannel thermometer, the “i” parameter specifies the channel to which the command is addressed). The “j”
parameter specifies the span that can range from 1.0 to 1000.0, in temperature units that are defined by the
last “u” command.
“t” or “t[i]” Returns the current temperature reading for channel # i. “---.-” is displayed if the specified channel
number is not currently enabled or when no valid temperature is available for the requested channel.
However, during the initial warm-up time, the error “Err1” is sent in response to the “t” command. For multichannel instruments, if the “t” command is received without parameter, the temperatures for all channels are
o
o
returned. All temperatures are returned in C or F unit, as specified by the “u” command.
ex:
“t4 E“ will return the temperature for channel # 4.
“t E”, with the FOB104 thermometer, will return:
+24.3<CR>
+24.5<CR>
+24.7<CR>
+24.4<CR>
*
The “t” command is also available in a special “ta” version, that can be useful for continuously and
automatically monitoring all enabled channels. This special mode is recommended when automatically
acquiring temperature readings with a suitable data-logging software, and can be activated by issuing the
“ta+” command, or deactivated with the “ta-“ command. Once activated, the following information is
automatically sent when the temperature on a channel has been acquired:
“C:I;T: ±xxx.x<CR>”
where i is the channel number, and xxx.x is the temperature reading (signed number). For the FOB101
model, i is always 1.
“u[i]” Set units of measurements to either Celsius (i=c) or Fahrenheit (i=f). Note that this unit selection is the
same as the temperature unit selection made from the keypad (if the display option is installed).
ex:
“uc E“, to select ºC (Celsius).
“y” The “y” command can be used to confirm the “signal strength” of a probe and/or its connection. It can be
used as a diagnostic tool to confirm the good operation of a probe and its patch cord (if applicable) connected
to a channel. The returned value can be between 0.3 to approximately 3.00; a higher value is better. A
minimum of 1.25 is required for a channel to return a temperature.
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ex:

“y E”, with the FOB104 thermometer, will return:
CH1: power:2.61, lamp attenuation: 250, CCD time: 50ms (fixed)<CR>
CH2: power:2.51, lamp attenuation: 250, CCD time: 50ms (fixed)<CR>
CH3: power:2.38, lamp attenuation: 125, CCD time: 50ms (fixed)<CR>
CH4: power:1.09*, lamp attenuation: 125, CCD time: 50ms (fixed)<CR>

*: 0.3 to 1.1 indicates that no probe is detected for this channel.
“z[j[“ or “z[i;j]” This command is used in conjunction with the “s” command, as it sets the temperature that
corresponds to the analog zero (minimum value of analog output). For multi-channel models, the “i”
parameter specifies the channel to which the command is addressed; valid values are 1, 2, 3 and 4. The “j”
parameter specifies the zero temperature value, and can range from -100.0 to 1000.0, in units that are
defined by the last “u” command. Factory default is -100.0.

5.4 Typical temperature reading sequence
Once all parameters have been set, the following sequence should normally be followed to extract
temperature information from your FOB100 thermometer. 2 procedures can be used for this purpose. The
first method consists in using the “ta” command (preferred), while the second sequence would be:
d)
The host computer should send the “t” (or “t[i]”) command, followed by a E character.
e)
The thermometer responds by echoing the requested temperature values, as indicated
above; the transmission is terminated by a “*” character.
f)
When the “*” character is received, it is suggested to immediately terminate the dialog
session by having the host computer issue the “r” command followed by a E character.
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6 ERROR CODES
The following error messages are displayed under certain error conditions:
RS-232
Err2

Display
Err2

Analog Out

“- - . -”
Err5
Err6

“- - - - -”

Hi-Lo, 0.5 Hz*

Description
Internal memory checksum error. Memory corruption.
Contact Omega.
Temperature out of maximum instrument limits or no signal
Argument out of range
Unrecognized command

*: The exact analog output behavior is a function of the command “o”; see previous Chapter.
Note that these error codes are not applicable when using the FOB100-SOFT software package. This highlevel software package is programmed to automatically handle all types of errors, as outlined in the next
section.
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7 FOB100-SOFT SOFTWARE PACKAGE
The FOB100-SOFT software package option allows using your thermometer system in a highly flexible
manner. The built-in functions allow for temperature displaying and data logging, as well as exporting to a
variety of standard spreadsheet packages. This software supports both the FOB100 series and HHTFO101
fiber optic thermometers.

7.1 Getting started with FOB100-SOFT
FOB100-SOFT was designed to acquire temperature readings from all models of the Omega FOB100
thermometer family. This versatile software package is designed to work with Microsoft Windows operating
system; to fully exploit the capabilities of FOB100-SOFT, it is recommended to use it in conjunction to
commercial spreadsheet software, such as Microsoft Excel.

7.1.1 Hardware and software requirements
The following list includes the minimum requirements for running the FOB100 software:
o
o
o
o
o
o
o
o

A Pentium class or higher CPU
SVGA or higher resolution display system supported by Windows
128 MB of RAM memory (operating system dependent)
At least 20 MB of hard disk space
A CD disk drive (to load software) (if requested, the software can be supplied on diskettes)
A mouse or other Windows pointing device
A RS-232 interface (COM1 to COM32). Up to 4 thermometer units are supported, each one
requiring its own COM port
Windows 2000 or later.

7.1.2 Installing FOB100-SOFT
You must have at least one, or more, properly installed FOB100 or HHTFO thermometer unit(s).
1- Start Windows, and make sure you are not running any other Windows program.
2- By inserting the CD in your computer, the SETUP application should automatically start; if not,
manually start it.
3- Follow the instructions that are displayed.
4- Restart your computer.

7.2 A quick tour of FOB100-SOFT
1- Connect your FOB100 and HHTFO unit(s) to free COM port(s).
2- Start FOB100-SOFT if not already running.
3- The thermometers that are turned on and connected to your PC through a proper RS-232
3
connection should normally be automatically detected by FOB100-SOFT (this process takes a few
seconds, for a typical installation).
4- If a thermometer is connected after FOB100-SOFT is started, you should click the “Refresh” button
so the software rescans the COM ports (1 to 32). If a thermometer is not automatically detected,
make sure your RS-232 port and cable is correctly configured and that the unit is turned on.
NOTE: Some RS-232C connections may cause transmission failures. Particularly, we have
experienced problems with the use of DB09 to DB25 converters and other similar so-called gender
changers. Also, some USB to RS232 converter/adapter are known to cause problems; Omega offers
excellent converters. Limit your cable lengths to 10 meters.
3

If the automatic COM port scanning is causing problems with some of your other programs, specific COM
ports can be excluded from being scanned. Refer to Section 7.5.1.3 for more information.
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You should normally see a window similar to this:

In this example, we see that FOB100-SOFT has detected 2 thermometers: a FOB104 and a HHTFO
instruments.
FOB100-SOFT is now properly installed and ready to use!

7.2.1 Working with the Configuration Window
FOB100-SOFT starts with the “Acquisition” window active, as shown in the figure above. To switch to the
“System Configuration” window, you need to click on one of the instrument names that have been detected;
for example, by clicking on “Omega FOB”, you will get the following window:
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For each instrument, this configuration window gives some information about this particular information and
allows you to set some parameters.
The top portion of the window gives information about the specifics of the thermometer, such as:
• COM Port number
• Serial Number
• Calibration date.
Description of the parameters that can be set:
o

o

•

Unit: You can select C or F.

•

Scan Rate: Fast (recommended for most application) or Slow.

•

Lock / Unlock Keypad (FOB100 series only): Can be selected to lock the keypad on the thermometer
unit. Warning: once locked, the keypad can only be unlocked through the use of FOB100-SOFT or
with the “l-“ serial command.

Furthermore, for each channel, you can set the following parameters:
•

On / Off: You can turn on or off the temperature for each channel.

•

Name: Up to 16 characters. You can enter a probe name here that suits your application.

•

Log: If checked, the temperature data for this channel will be logged, when data logging is active.

•

Chart: If checked, the temperature data for this channel will be displayed when one of the 4 chart
windows is open.

•

Color: This is the color of the curve that will be used when the Chart window is open.

•

Alarms, Min and Max: Allows setting alarm limits. When one of more alarms are detected, a
message is given at the bottom of the main window (must be in Acquisition mode). For a given
channel, alarms are monitored only when its corresponding “Chart” or “Log” checkbox is checked, in
the Configuration window pane. Alarms are monitored only when Acquisition is active.

•

Analog Outputs (FOB100 series only): Allows configuring the analog output parameters, Zero and
Span. See Section 5.3 for a complete description of these parameters.

•

Offset: Allows adding an offset to this channel. See below.

7.2.1.1

Adjusting a temperature offset

FOB100-SOFT allows you to add an offset to the temperature readings that are returned by a thermometer.
This feature is equivalent to the “f” serial command, as described in Section 5.3, although it implementation in
FOB100-SOFT is somewhat different than it is for the serial command.
An offset can be useful for the following two cases:
1- To temporarily change the reading of a probe that is believed to be in error (one-point calibration
procedure). This usually requires that a good temperature reference be available.
2- To force an offset to a reading, for example may want to monitor a temperature variation from a
given set temperature. In this case, you can simply enter the “0” value as a forced temperature
setting, and the resulting reading will give you a + or - deviation from the set temperature point.
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Warning:: Doing a temperature offset adjustment on a channel will alter its reading. In effect, it alters the
thermometer own calibration.
libration. It must be used with care!
To perform an offset adjustment, follow these instructions:
1- Click the “Offset Adjust” button (
) that is just next to the channel number you want to calibrate.
The following menu window is available:

2- Type in the
e “Set Point” box the actual temperature that you would like to force for this channel (this
temperature is normally obtained using an accurate NIST
NIST-certified
certified primary temperature reference).
3- Press the “OK” button to activate the reference temperature. The “Offset” value will reset to its new
value, as a result of your new forced temperature; this new offset is now displayed in the main
window.
4- To reset this forced temperature setting, go back to the “Channel Offset” window, and click the Clear
button.
5- Repeat
peat the same procedure for the other channels that you want to modify.

7.3 Acquiring and viewing temperature data
Once all your thermometers are properly connected and configured, you may want to log data to a file, or to
display their values on screen. A num
number of tools are available for that.
To view or acquire data, the “Acquisition” pane must be active.

7.3.1 Logging temperature data to a file
FOB100-SOFT offers the possibility to log temperature values to an Excel compatible file. The default file
extension is .tem; this file can be subsequently open using Excel, which should open it and automatically
recognize as an Excel compatible file (tab delimited).
The parameters that are useful to control the logging are shown in the lower left portion of the window, as
shown here:

•

To set the logging filename, click on “SAVE AS…”; this allows you to enter a file name. For
information, the current filename is d
displayed just below this button.

•

To set the acquisition rate, enter a number, in seconds, in the appropriate text box. Rate can be set
from 0.2 to 3600 seconds.
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•

To start acquiring data, click the “START” button. Conversely, to stop the acquisition, click the
“STOP” button.

When subsequently trying to opening the *.tem file, it is possible that you may get the following message:

Select “Select the program from a list”, and click OK. In the next window, you should instruct Windows to
always open this type of file with Microsoft Excel.
If you get the following message, you should select “Read Only”.

In Excel, the data file should look like this:

Notes:

1) If a column shows “#######”, this means that this column is too narrow to display the data; use
your mouse to widen this column.
2) If you open a logging file during acquisition, the Excel window is not refreshed as the
acquisition is taking place. To get a more recent version of the file, close the Excel program, and
start Excel again.
3) A value of -999.xx indicates that no reading is available for this channel. Check the probe
connection.

If you stop the acquisition, and start it again with the same file name, the new values will simply be appended
to the existing file content. However, a new 4-line header is inserted first, as shown here:
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When logging temperatures for a very long time, one needs to note that a standard Excel sheet is limited to
65535 lines. If this limit is reached (65000 lines), the logging process will close the current data-logging file,
and will open a new one, with the same name but with “_1” appended to the file name, and so on (“_2” …),
until the application is stopped or your disk becomes full.

7.3.2 Viewing temperature data
Temperature values can be displayed on your computer screen in a number of ways. Click one of the four
“Chart” button to active one or more of these windows.

Note that more than one window type can be displayed simultaneously; in addition, you can log temperatures
to a file independently from these display windows. Note that each of these 2 modes have each then own
acquisition time base.

7.3.2.1

Displaying temperature trends

Click the “Chart” button to get the following window.
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Adjust the “Refresh Rate” (minimum is 0.2 sec) and Min / Max to suit your viewing needs.
Note that the setting of curve colors and other parameters must be done in the “System Configuration”
window pane. Up to 64 trends can be displayed.

7.3.2.2

Displaying analog thermometers

Click the “Thermo” button; the following window will appear.

All thermometers share the same Min / Max reading setting. Refresh rate is fixed at 1.0 sec. The size of this
window will change depending on the number of channels to display. Up to 16 thermometers can be shown;
if you want to display more than 16 channels, only the first 16 detected channels will be shown (note that any
channel that has its “Chart” checkbox unchecked, in the main window, will not be shown).
If an alarm is active for a channel, the corresponding thermometer numbers will change color: blue for a low
temperature alarm, or red for a high temperature alarm.

7.3.2.3

Displaying digital values

To display digital temperatures, click on the “Digital” button. The following window will appear.

The size of this window will adapt to the number of channels to display. Up to 32 values can be shown.
Refresh rate is always 1.0 sec. This window is re-scalable.
If an alarm is active for a channel, the corresponding display will change color: blue for a low temperature
alarm, or red for a high temperature alarm.

7.3.2.4

Displaying analog values (dials)

To display analog temperatures (using dials), click on the “Analog” button. The active window becomes this:
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All dials share the same Min / Max reading setting. Refresh rate is always 1.0 sec. The size of this window
will adapt to the number of displayed channels. Up to 16 dials can be shown; if you want to display more than
16 channels, only the first 16 detected channels will be shown (note that any channel that has its “Chart”
checkbox unchecked, in the main window, will not be shown).
If an alarm is active for a channel, the corresponding dial numbers will change color: blue for a low
temperature alarm, or red for a high temperature alarm.

7.4 The FOB100 Console
You must be in “System Configuration” mode to use the console. The Console should be used only by
experienced users.
The console, which can be invoked through the Window and then Open Console from FOB100-SOFT main
window menu bar, is useful to manage each Omega thermometer in details. Take note that the console can
only be open when no temperature acquisition is taking place. It can be useful also to understand problems
and malfunctions that a module may exhibit. It operates in a similar fashion as Windows HyperTerminal.
The console can be used to get information such as:
•

Information on calibration date, serial number, etc.

•

Enable / disable channels

•

Set the analog output parameters (zero and span)

•

Control operational features, such as fast/slow scanning more, etc.

•

And so forth.

The following illustrates the FOB100 Console:
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Before sending commands and receiving information from a specific module, it is necessary to select the
instrument you want to interrogate. Please note that only ONE instrument can be selected at a time; if the
same command is to be sent to all thermometers, then, it is necessary to repeat the command for each
individual module.
You can use “Copy and Paste” Windows commands (such as the following shortcuts: ctl-c and ctl-v) to copy
selected content of the console content to other Windows programs, such as Notepad, etc.

7.4.1 Console help menu
The following is the menu as displayed by the instrument when sending the “h” command. This help menu
can be used as a reminder of all available commands, for this specific instruments.

For a complete description of all commands, refer to Section 5.3 above.

7.5 FOB100-SOFT functions
This section explains in details each one of the functions provided by the menus of the FOB100-SOFT
software package. This Section only gives a brief overview of the commands that are possible; for operational
details, please refer to the above Sections.

7.5.1 The File menu
The File menu provides the user with basic functions to handle Configuration files.

7.5.1.1

Find Instruments (Refresh)

This is equivalent to the “Refresh” button, found on the main window.

7.5.1.2

Disconnect Instruments

This will release all COM ports, select this menu item. FOB100-SOFT becomes idle, and to bring it to life
again requires you to click the “Refresh” button (or to select the Find Instruments (Refresh)” menu item
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7.5.1.3

Advance serial port setting

This command allows the user to force the exclusion of one or more COM ports from being scanned when
clicking the “Refresh” button. This may be useful when one finds that the automatic COM port refresh feature
of FOB100-SOFT is interfering with equipment that are using defined COM ports. You can check all ports
that you want to exclude from the automatic scanning process. This window looks like this:

7.5.1.4

Quit

Select Quit from the File menu to exit FOB100-SOFT. Any configuration or setting that you might have done
to any parameters is automatically saved, so the same configuration will be available the next time you open
FOB100-SOFT.

7.5.2 The Window menu
From this menu, you can open the following 5 windows:
• Console view
• Trend view
• Thermometer view
• Digital view
• Analog (dial) view.

7.5.2.1

Open Console

Open Console can be very useful for developers and other users who want to interrogate the “internal”
parameters of an Omega thermometer. It should be used only by experienced users.

7.5.2.2

View Trends

Select this menu item to open a window that gives you a graphical representation of your temperature
readings, as a function of time. Up to 64 curves can be simultaneously displayed. The sampling time base is
adjustable.

7.5.2.3

View Thermometers

Select this menu item to display thermometers that will give you temperature data on up to 16 channels.
Sampling rate is fixed at one reading per second.

7.5.2.4

View Digital meters

Select this menu item to display digital readouts that will give you temperature data on up to 32 channels.
Sampling rate is fixed at one reading per second.

7.5.2.5

View Analog Dial meters

Select this menu item to display analog dials that will give you temperature data on up to 16 channels.
Sampling rate is fixed at one reading per second.

7.5.3 The Help Menu
This is a standard Windows Help menu.
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Blank.
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MADE IN
CANADA

WARRANTY/DISCLAIMER

OMEGA ENGINEERING, INC. warrants this unit to be free of defects in materials and workmanship for a
period of 13 months from date of purchase. OMEGA’s WARRANTY adds an additional one (1) month
grace period to the normal one (1) year product warranty to cover handling and shipping time. This
ensures that OMEGA’s customers receive maximum coverage on each product.
If the unit malfunctions, it must be returned to the factory for evaluation. OMEGA’s Customer Service
Department will issue an Authorized Return (AR) number immediately upon phone or written request.
Upon examination by OMEGA, if the unit is found to be defective, it will be repaired or replaced at no
charge. OMEGA’s WARRANTY does not apply to defects resulting from any action of the purchaser,
including but not limited to mishandling, improper interfacing, operation outside of design limits,
improper repair, or unauthorized modification. This WARRANTY is VOID if the unit shows evidence of
having been tampered with or shows evidence of having been damaged as a result of excessive corrosion;
or current, heat, moisture or vibration; improper specification; misapplication; misuse or other operating
conditions outside of OMEGA’s control. Components in which wear is not warranted, include but are not
limited to contact points, fuses, and triacs.
OMEGA is pleased to offer suggestions on the use of its various products. However,
OMEGA neither assumes responsibility for any omissions or errors nor assumes liability for any
damages that result from the use of its products in accordance with information provided by
OMEGA, either verbal or written. OMEGA warrants only that the parts manufactured by the
company will be as specified and free of defects. OMEGA MAKES NO OTHER WARRANTIES OR
REPRESENTATIONS OF ANY KIND WHATSOEVER, EXPRESSED OR IMPLIED, EXCEPT THAT OF
TITLE, AND ALL IMPLIED WARRANTIES INCLUDING ANY WARRANTY OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE HEREBY DISCLAIMED. LIMITATION OF
LIABILITY: The remedies of purchaser set forth herein are exclusive, and the total liability of
OMEGA with respect to this order, whether based on contract, warranty, negligence,
indemnification, strict liability or otherwise, shall not exceed the purchase price of the
component upon which liability is based. In no event shall OMEGA be liable for
consequential, incidental or special damages.
CONDITIONS: Equipment sold by OMEGA is not intended to be used, nor shall it be used: (1) as a “Basic
Component” under 10 CFR 21 (NRC), used in or with any nuclear installation or activity; or (2) in medical
applications or used on humans. Should any Product(s) be used in or with any nuclear installation or
activity, medical application, used on humans, or misused in any way, OMEGA assumes no responsibility
as set forth in our basic WARRANTY/DISCLAIMER language, and, additionally, purchaser will indemnify
OMEGA and hold OMEGA harmless from any liability or damage whatsoever arising out of the use of the
Product(s) in such a manner.

RETURN REQUESTS/INQUIRIES
Direct all warranty and repair requests/inquiries to the OMEGA Customer Service Department. BEFORE
RETURNING ANY PRODUCT(S) TO OMEGA, PURCHASER MUST OBTAIN AN AUTHORIZED RETURN
(AR) NUMBER FROM OMEGA’S CUSTOMER SERVICE DEPARTMENT (IN ORDER TO AVOID
PROCESSING DELAYS). The assigned AR number should then be marked on the outside of the return
package and on any correspondence.
The purchaser is responsible for shipping charges, freight, insurance and proper packaging to prevent
breakage in transit.
FOR WARRANTY RETURNS, please have the
following information available BEFORE
contacting OMEGA:
1. Purchase Order number under which the product
was PURCHASED,
2. Model and serial number of the product under
warranty, and
3. Repair instructions and/or specific problems
relative to the product.

FOR NON-WARRANTY REPAIRS, consult OMEGA
for current repair charges. Have the following
information available BEFORE contacting OMEGA:
1. Purchase Order number to cover the COST
of the repair,
2. Model and serial number of the product, and
3. Repair instructions and/or specific problems
relative to the product.

OMEGA’s policy is to make running changes, not model changes, whenever an improvement is possible. This affords
our customers the latest in technology and engineering.
OMEGA is a registered trademark of OMEGA ENGINEERING, INC.
© Copyright 2008 OMEGA ENGINEERING, INC. All rights reserved. This document may not be copied, photocopied,
reproduced, translated, or reduced to any electronic medium or machine-readable form, in whole or in part, without the
prior written consent of OMEGA ENGINEERING, INC.
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